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1. Product Overview 

1.1 Introduction 

Matrix-700 is a Cortex-A5 based industrial embedded Linux computer.  The Matrix-700 is especially 

suitable for 24/7/365 non-stop running for unmanned application environment.  The Matrix-700’s Linux 

system is 95% similar to a generic Debian-based Linux platform (e.g. Ubuntu). 

 

1.2 Features 

 Cortex-A5 Processor 536MHz with ARMv7 set 

 512MB LPDDR2 RAM, 8GB eMMC Flash 

 One Gigabit and one 10/100Mbps Ethernet ports 

 Two USB 2.0 high speed (480Mbps) Host ports 

 Four software configurable RS-232/485 serial ports 

 One USB client port  

 One microSD socket 

 9 to 48VDC power input 

 Pre-installed Linux kernel 4.4.XX and file system 

 GNU toolchain available on Artila self-maintained repository 

 Optional DIN RAIL mounting adaptor 

 

1.3 Packing List 

 Matrix-700 Box Computer 

 

1.4 Optional Accessory 

 91-R45F9-150: Serial Cable (RJ45 to DB9 Female, 150cm)  

 DK-35A: DIN RAIL Mounting Kit 

 PWR-12V-1A: 110~240VAC to 12VDC 1A Power Adaptor 
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2. Hardware Introduction 

2.1 Layout 
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2.2 Serial Port 

The Matrix-700 provides four RJ45 connectors for it’s four serial ports. Each serial port can be 

configured as RS-232 or RS-485 by software.  The Matrix-700’s RS-485 supports automatic direction 

control (by hardware).  The detailed pin assignment information is shown below: 

 

 Pin No. RS-232 RS-485 

1 DSR - 

2 RTS DATA+ 

3 GND GND 

4 TXD DATA- 

5 RXD -- 

6 DCD - 

7 CTS - 

8 DTR - 

 

2.3 Hardward connection 

 Micro-USB connector 

 Support USB power source 

 USB client as serial console 
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3. Getting Start to Use Matrix-700 

3.1 Power on the Matrix-700  

The Matrix-700 can be powered via its terminal block (9-48VDC), and/or via its micro-USB connector 

(5VDC).  After power on:  

 The Matrix-700 will beep once and the P4 LED will lit up (yellow).  

 Then the ready LED (green) will flash four times. 

 Then all LEDs will be off for about 25 seconds while loading the Linux kernel. 

 Then the ready LED will turn on again, which means the Matrix-700 is ready to use.  

 

3.2 Access the USB Serial Console Shell 

The Matrix-700 supports USB serial console shell.  Please prepare an USB to micro-USB cable to 

connect the Matrix-700 to your computer.  After boot-up, the Matrix-700 automatically emulates an 

USB CDC/ACM compatible serial device, the serial communication parameters are: 115200, N81, 

VT100.  

 

Plug the USB cable to your computer, there should be a newly installed serial port.  The identifier 

name of the serial port varies depending on your computer’s operation system and the number of the 

serial port already installed on your computer. 

 On Linux system, the serial port name looks like ttyACM0, ttyACM1, etc. 

 On OSX system, the serial port name looks like tty.usbmodem1421, tty.usbmodem1422, etc. 

 On Windows system, the serial port name looks like COM3, COM4, etc.  

 

Use your preferred serial terminal programs to access the Matrix-700’s USB serial console, e.g. putty 

for Windows computers, and minicom for Linux/OSX computers. 

 

 Note 

1. For Linux, Mac OSX and Windows 10 computers, the CDC/ACM serial driver is already built-in and will be 

activated automatically.   

2. For Windows 7/XP computers, it may need to install the CDC/ACM serial driver manually.  Users can 

download the CDC/ACM driver from Artila web site. 

(http://www.artila.com/download/A5D35/Linux/toolchain/linux-cdc-acm.inf). 
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4. Network Interface Settings 

The Matrix-700 comes with two Ethernet ports, the default network settings are shown below: 

 

Ethernet Type Port Label Port mapping IP mode IP address 

Gigabit GLAN eth0 dynamic assigned by DHCP server 

10/100Mbit LAN eth1 static 192.168.2.127 

 

You may need to modify the Matrix-700’s network settings to meet your LAN environment.  The 

configuration file path is /etc/network/interfaces.  Save the configuration file, and use ifdown and ifup 

command to ON/OFF the specific network interface a couple times to activate the network settings. 

 

[root@Matrix700 ~]#cat /etc/network/interfaces 

# /etc/network/interfaces -- configuration file for ifup(8), ifdown(8) 

  

# The loopback interface 

auto lo 

iface lo inet loopback 

  

# Wired or wireless interfaces 

# Gigabit 

auto eth0 

iface eth0 inet dhcp 

  

# 10/100M 

auto eth1 

iface eth1 inet static 

        address 192.168.2.127 

        netmask 255.255.255.0 

        network 192.168.2.0 

        #gateway 192.168.2.1 

  

[root@Matrix700 ~]# 

 

The following screen capture shows the eth0 of the Matrix-700 got a valid IP: 192.168.1.64. 

 

[root@Matrix700 ~]#ifdown eth0  

[root@Matrix700 ~]#ifup eth0 

udhcpc (v1.23.2)  

started Sending discover...  

Sending select for 192.168.1.64...  

Lease of 192.168.1.64 obtained, lease time 86400  

/etc/udhcpc.d/50default: Adding DNS 208.67.220.220  

/etc/udhcpc.d/50default: Adding DNS 208.67.222.222  

 

[root@Matrix700 ~]# 
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5. Access the SSH Console Shell 

Most Linux/OSX computers come with built-in SSH client utility.  For Windows users, it is highly 

recommended to use putty as an SSH client. 

 

$ ssh root@192.168.1.64 

The authenticity of host '192.168.1.64 (192.168.1.64)' can't be establis

hed. ECDSA key fingerprint is SHA256:gQQ9QzBGV0F0fZCmP5qLxioRkbPlRqJDLn

LuklLZVhQ. Are you sure you want to continue connecting (yes/no)? yes Wa

rning: Permanently added '192.168.1.64' (ECDSA) to the list of known hos

ts. root@192.168.1.64's  

password:  

Last login: Fri May 6 20:47:14 2016 from 192.168.1.54 Welcome to 

 

      **                    **  **             

      **              **        **             

    **  **            **        **             

    **  **      ****  ****  **  **    ******   

  **      **    **    **    **  **          ** 

  **      **    **    **    **  **    ******** 

  **********    **    **    **  **  **      ** 

**          **  **    **    **  **  **      ** 

**          **  **      **  **  **    ******** 

 

For further information check: 

http://www.artila.com/  

 

[root@Matrix700 ~]# 

 

 

 

 

mailto:root@192.168.1.64's
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6. Check the Linux Kernel Version 

 

 [root@Matrix700 ~]#uname -a 

Linux Matrix700 3.18.34-yocto-standard #1 Tue May 24 21:14:06 CST 2016 ar

mv7l GNU/Linux 

 

[root@Matrix700 ~]#uname -r 

3.18.34-yocto-standard 

 

[root@Matrix700 ~]#uname -v 

#1 Tue May 24 21:14:06 CST 2016 
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7. File System Information 

The Matrix-700 comes with 8GB on-board EMMC Flash memory, which contains boot loader (uBoot), 

Linux kernel, root file system and user disk (/home). 

 

[root@Matrix700 ~]#lsblk 

NAME        MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT 

mmcblk0     179:0    0  7.3G  0 disk 

`-mmcblk0p1 179:1    0  7.3G  0 part / 

mtdblock0    31:0    0  8.3M  0 disk 

mtdblock1    31:1    0  8.2M  0 disk 

mtdblock2    31:2    0  7.7M  0 disk 

mtdblock3    31:3    0  7.7M  0 disk 

mtdblock4    31:4    0  7.6M  0 disk 

mtdblock5    31:5    0  3.9M  0 disk 

 

[root@Matrix700 ~]# 

 

 

 

[root@Matrix700 /]#ls -F 

bin/   dev/  home/  lost+found/  mnt/   run/   sys/  usr/ 

boot/  etc/  lib/   media/       proc/  sbin/  tmp@  var/ 

 

[root@Matrix700 /]# 

 

[root@Matrix700 ~]#df -h 

Filesystem      Size  Used Avail Use% Mounted on 

/dev/root       7.1G  252M  6.5G   4% / 

devtmpfs        251M     0  251M   0% /dev 

tmpfs           251M   72K  251M   1% /run 

tmpfs           251M  104K  251M   1% /var/volatile 

 

[root@Matrix700 ~]# 
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8. Serial Port Settings 

The Matrix-700 comes with four RS-232/485 serial ports.  The port mapping info is listed below: 

 Port 1  /dev/ttyS1 

 Port 2  /dev/ttyS2 

 Port 3  /dev/ttyS3 

 Port 4  /dev/ttyS4 

 

The serial port’s default operation mode is RS-232.  Please use the built-in setuart utility to 

show/change serial port’s operation mode.  

 

 Caution 

The serial port’s mode will go back to RS-232 mode after system reboot. 

 

Configure serial port setting.  An example show as followed to configure port1 as RS-485 or RS-232 

interface with baud 115200 or baud 9600. 

 

[root@Matrix700 ~]#setuart -h 

Artila utility: setuart 

Usage: setuart [OPTION] 

 

 -h         display this help and exit 

 -v         print version number and exit 

 -p         uart port number 

 -t         uart interface type [232,485] 

 -b         set baudrate, up to 921600bps 

 

Examples: 

  setuart -p 1                      display port 1 type and baudrate 

  setuart -p 1 -t 485 -b 115200     set port 1 type RS-485 and baud to 115

200 

  setuart -p 1 -t 232 -b 9600       set port 1 type to RS-232 and baud to 

9600 
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9. System Time and Real-time Clock 

9.1 Adjust the System Time by Date Command  

Matrix-700 supports standard date command to adjust the Linux system time manually.  A typical 

usage is: date MMDDhhmmYYYY. 

 

[root@Matrix700 ~]#date 050717132016 

Sat May 7 17:13:00 UTC 2016 

 

[root@Matrix700 ~]# 

 

9.2 Adjust the RTC Time by hwclock Command  

If users want to adjust the Matrix-700’s on-board Real-time clock (RTC), please follow the steps shown 

below: 

 First, to adjust the system time by using date or ntpclient command. 

 Then use the hwclock command to synchronize the system time to the RTC.  A typical usage is: 

hwclock -w. 

 

[root@Matrix700 ~]#hwclock 

Thu May 26 15:31:49 2016  0.000000 seconds 

 

[root@Matrix700 ~]#date 

Thu May 26 15:32:00 UTC 2016 

 

[root@Matrix700 ~]#hwclock -w 

 

[root@Matrix700 ~]# 

 

9.3 Using NTP (Network Time Protocol)  

Matrix-700 comes with pre-activated ntpd daemon.  The NTP configuration file path is /etc/ntp.conf. 

The default NTP settings is shown below: 

 

[root@Matrix700 ~]#cat /etc/ntp.conf 

# This is the most basic ntp configuration file 

# The driftfile must remain in a place specific to this 

# machine - it records the machine specific clock error 

driftfile /var/lib/ntp/drift 

# This should be a server that is close (in IP terms) 

# to the machine.  Add other servers as required. 

# Unless you un-comment the line below ntpd will sync 

# only against the local system clock. 

# 

# server time.server.example.com 

# 

# Using local hardware clock as fallback 

# Disable this when using ntpd -q -g -x as ntpdate or it will sync to itse

lf 

server 127.127.1.0 

fudge 127.127.1.0 stratum 14 

# Defining a default security setting 

restrict default 
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 If you just want to synchronise network time server, the configuration file is shown below: 

[root@Matrix700 ~]#cat /etc/ntp.conf 

# This is the most basic ntp configuration file 

# The driftfile must remain in a place specific to this 

# machine - it records the machine specific clock error 

driftfile /var/lib/ntp/drift 

# This should be a server that is close (in IP terms) 

# to the machine.  Add other servers as required. 

# Unless you un-comment the line below ntpd will sync 

# only against the local system clock. 

# 

# server time.server.example.com 

# 

# Using local hardware clock as fallback 

# Disable this when using ntpd -q -g -x as ntpdate or it will sync to itse

lf 

#server 127.127.1.0 

#fudge 127.127.1.0 stratum 14 

server 0.pool.ntp.org prefer 

server 1.pool.ntp.org 

server 2.pool.ntp.org 

server 3.pool.ntp.org 

# Defining a default security setting 

restrict default 

 

 

 Restart the ntpd service: execute /etc/init.d/ntpd restart 

 Stop the ntpd service: execute /etc/init.d/ntpd stop 

 Disable the ntpd service on boot-up: execute rm /etc/rc5.d/S20ntpd. For more details, please  

follow the link: http://www.pool.ntp.org/ 
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10. Insert Kernel Modules 

Users can use command lsmod to list all installed kernel modules. 

 

[root@Matrix700 ~]#lsmod 

Module                  Size  Used by 

usb_f_mass_storage     26778  2 

usb_f_acm               4036  2 

u_serial                7534  3 usb_f_acm 

libcomposite           33729  12 usb_f_acm,usb_f_mass_storage 

nfsd                  287575  11 

auth_rpcgss            49151  1 nfsd 

oid_registry            2189  1 auth_rpcgss 

exportfs                3309  1 nfsd 

nfs_acl                 2274  1 nfsd 

lockd                  71884  1 nfsd 

grace                   2364  2 nfsd,lockd 

sunrpc                208345  12 nfsd,auth_rpcgss,lockd,nfs_acl 

atmel_usba_udc         12929  0 

udc_core                5977  2 atmel_usba_udc,libcomposite 

 

[root@Matrix700 ~]# 

 

 

To load additional kernel modules during the system boot-up, you can modify the file: /etc/modules. 

 

[root@Matrix700 ~]#cat /etc/modules 

atmel_usba_udc 

#g_serial 

#mt7601Usta 

 

[root@Matrix700 ~]# 
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11. Install Software Package 

The Matrix-700 supports standard apt (Advanced Package Tool) package management utility.  With 

this utility, users can easily install, upgrade, remove software packages.  Artila provides a 

self-maintained software repository.  The apt configuration file path is /etc/apt/sources.list.  

 

[root@Matrix700 ~]#ls /etc/apt  

apt.conf  apt.conf.d  preferences.d  sources.list  sources.list.d 

 

[root@Matrix700 ~]#cat /etc/apt/sources.list 

deb http://www.artila.com/download/deb/Matrix700 Matrix700 main 

deb http://www.artila.com/download/deb/cortexa5hf-vfp cortexa5hf-vfp ma

in 

deb http://www.artila.com/download/deb/all all main 

 

 

Commonly used apt commands are listed below: 

 apt-get install <package> to install package 

 apt-get remove <package> to remove package 

 apt-cache search <package> to search package 

 apt-get update to update the package list 

 apt-get upgrade to upgrade installed packages 
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12. Mount an SD Card 

The Matrix-700 comes with a MicroSD socket.  If an MicroSD card is inserted, you can use lsblk 

command to find the device identifier name.  And then use mount command to mount the SD card to 

a folder. 

 

Before SD Insertion 

 

[root@Matrix700 ~]#lsblk 

NAME        MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT 

mmcblk0     179:0    0  7.3G  0 disk 

`-mmcblk0p1 179:1    0  7.3G  0 part / 

mtdblock0    31:0    0  8.3M  0 disk 

mtdblock1    31:1    0  8.2M  0 disk 

mtdblock2    31:2    0  7.7M  0 disk 

mtdblock3    31:3    0  7.7M  0 disk 

mtdblock4    31:4    0  7.6M  0 disk 

mtdblock5    31:5    0  3.9M  0 disk 

 

After SD Insertion 

 

[root@Matrix700 ~]#lsblk 

NAME        MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT 

mmcblk0     179:0    0  7.3G  0 disk 

`-mmcblk0p1 179:1    0  7.3G  0 part / 

mmcblk1     179:24   0  1.9G  0 disk 

mtdblock0    31:0    0  8.3M  0 disk 

mtdblock1    31:1    0  8.2M  0 disk 

mtdblock2    31:2    0  7.7M  0 disk 

mtdblock3    31:3    0  7.7M  0 disk 

mtdblock4    31:4    0  7.6M  0 disk 

mtdblock5    31:5    0  3.9M  0 disk 

 

 

Mount mmcblk1 to /media. 

[root@Matrix700 ~]#mount /dev/mmcblk1 /media 

[root@Matrix700 ~]#lsblk 

NAME        MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT 

mmcblk0     179:0    0  7.3G  0 disk 

`-mmcblk0p1 179:1    0  7.3G  0 part / 

mmcblk1     179:24   0  1.9G  0 disk /media 

mtdblock0    31:0    0  8.3M  0 disk 

mtdblock1    31:1    0  8.2M  0 disk 

mtdblock2    31:2    0  7.7M  0 disk 

mtdblock3    31:3    0  7.7M  0 disk 

mtdblock4    31:4    0  7.6M  0 disk 

mtdblock5    31:5    0  3.9M  0 disk 

 

 

Unmount /media. 

[root@Matrix700 ~]#umount /media 

 

 

 

 



Matrix-700 User Guide 

‧15‧ 

13. Mount a USB Drive 

The Matrix-700 comes with two USB host ports which support generic USB drives.  If a USB drive is 

inserted, you can use lsblk command to find the device identifier name.  And then use mount 

command to mount the USB drive to a folder. 

 

Before USB drive Insertion 

 

[root@Matrix700 ~]#lsblk 

NAME        MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT 

mmcblk0     179:0    0  7.3G  0 disk 

`-mmcblk0p1 179:1    0  7.3G  0 part / 

mtdblock0    31:0    0  8.3M  0 disk 

mtdblock1    31:1    0  8.2M  0 disk 

mtdblock2    31:2    0  7.7M  0 disk 

mtdblock3    31:3    0  7.7M  0 disk 

mtdblock4    31:4    0  7.6M  0 disk 

mtdblock5    31:5    0  3.9M  0 disk 

 

After USB drive Insertion 

 

[root@Matrix700 ~]#lsblk 

NAME        MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT 

sda           8:0    1 14.5G  0 disk 

`-sda1        8:1    1 14.5G  0 part 

mmcblk0     179:0    0  7.3G  0 disk 

`-mmcblk0p1 179:1    0  7.3G  0 part / 

mtdblock0    31:0    0  8.3M  0 disk 

mtdblock1    31:1    0  8.2M  0 disk 

mtdblock2    31:2    0  7.7M  0 disk 

mtdblock3    31:3    0  7.7M  0 disk 

mtdblock4    31:4    0  7.6M  0 disk 

mtdblock5    31:5    0  3.9M  0 disk 

 

 

Mount sda1 to /media. 

[root@Matrix700 ~]#mount /dev/sda1 /media 

[root@Matrix700 ~]#lsblk 

NAME        MAJ:MIN RM  SIZE RO TYPE MOUNTPOINT 

sda           8:0    1 14.5G  0 disk 

`-sda1        8:1    1 14.5G  0 part /media 

mmcblk0     179:0    0  7.3G  0 disk 

`-mmcblk0p1 179:1    0  7.3G  0 part / 

mtdblock0    31:0    0  8.3M  0 disk 

mtdblock1    31:1    0  8.2M  0 disk 

mtdblock2    31:2    0  7.7M  0 disk 

mtdblock3    31:3    0  7.7M  0 disk 

mtdblock4    31:4    0  7.6M  0 disk 

mtdblock5    31:5    0  3.9M  0 disk 

 

 

Unmount /media. 

[root@Matrix700 ~]#umount /media 
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14. Web Server Settings 

14.1 Nginx Web Server  

The Matrix-700 comes with pre-installed nginx web server.  The configuration file is 

/etc/nginx/nginx.conf. 

 

 

 

14.2 Root Web Page Directory 

The default root web page directory path is /var/www/localhost/html.  This path can be changed by 

modifying the above configuration file. 

 

[root@Matrix700 ~]#ls /var/www/localhost/html 

50x.html  index.html 

 

[root@Matrix700 ~]# 
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15. Auto-start a Program after System Boot-up 

To automatically start a program after system boot-up, please edit a shell script to execute the program, 

and put that script file to the folder: /etc/rc5.d. 

 

[root@Matrix700 ~]#ls /etc/rc5.d 

S01networking  S12rpcbind      S20atd         S20syslog  S99readyled       

S99usbgadget 

S02dbus-1      S15mountnfs.sh  S20hwclock.sh  S90crond   S99rmnologin.sh 

  S99webmin 

S09sshd        S19nfscommon    S20nfsserver   S92nginx   S99stop-bootlogd 

 

[root@Matrix700 ~]# 
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16. Change Welcome Message 

The welcome message file is /etc/motd, the default content is shown below, modify the content at your 

will. 

 

[root@Matrix700 ~]#cat /etc/motd 

Welcome to 

  

      **                    **  **             

      **              **        **             

    **  **            **        **             

    **  **      ****  ****  **  **    ******   

  **      **    **    **    **  **          ** 

  **      **    **    **    **  **    ******** 

  **********    **    **    **  **  **      ** 

**          **  **    **    **  **  **      ** 

**          **  **      **  **  **    ******** 

  

For further information check: 

http://www.artila.com/ 

  

[root@Matrix700 ~]# 
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17. Re-boot the Matrix-700 

To re-boot the Matrix-700, use the reboot command. 

 

[root@Matrix700 ~]#reboot 

  

Broadcast message from root@Matrix700 (ttyGS0) (Sun May 8 15:51:47 201

6): 

The system is going down for reboot NOW! 
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18. User Application Development 

18.1 Install the C/C++ Cross Compilation Toolchain 

The following instructions are based on 64-bit Ubuntu Linux environment.  

Step 1: Download the toolchain installation script from Artila’s website, the URL is: 

$ wget http://www.artila.com/download/deb/sdk/poky-glibc-x86_64-artila-f

ull-cmdline-cortexa5hf-vfp-toolchain-2.0.2.sh 

 

Step 2: Execute the toolchain installation script. 

$ sh poky-glibc-x86_64-artila-full-cmdline-cortexa5hf-vfp-toolchain-2.0.

2.sh 

 

Step 3: Source the environment file setup script. 

$ source /opt/poky/2.0.2/environment-setup-cortexa5hf-vfp-poky-linux-gnu

eabi 

 

$ wget http://www.artila.com/download/deb/sdk/poky-glibc-x86_64-artila-

full-cmdline-cortexa5hf-vfp-toolchain-2.0.2.sh 

--2016-06-02 10:44:34--  http://www.artila.com/download/deb/sdk/poky-gl

ibc-x86_64-artila-full-cmdline-cortexa5hf-vfp-toolchain-2.0.2.sh 

Resolving www.artila.com (www.artila.com)... 50.87.93.43 

Connecting to www.artila.com (www.artila.com)|50.87.93.43|:80... connec

ted. 

HTTP request sent, awaiting response... 200 OK 

Length: 552225625 (527M) [application/x-sh] 

Saving to: ‘poky-glibc-x86_64-artila-full-cmdline-cortexa5hf-vfp-toolch

ain-2.0.2.sh’ 

 

 

$ sh poky-glibc-x86_64-artila-full-cmdline-cortexa5hf-vfp-toolchain-2.

0.2.sh  

Poky (Yocto Project Reference Distro) SDK installer version 2.0.2 

================================================================= 

Enter target directory for SDK (default: /opt/poky/2.0.2):  

The directory "/opt/poky/2.0.2" already contains a SDK for this architec

ture. 

If you continue, existing files will be overwritten! Proceed[y/N]? y 

[sudo] password for uj:  

Extracting SDK....................................................

 .....................done 

Setting it up...done 

SDK has been successfully set up and is ready to be used. 

Each time you wish to use the SDK in a new shell session, you need to sou

rce the environment setup script e.g. 

 $ . /opt/poky/2.0.2/environment-setup-cortexa5hf-vfp-poky-linux-gnueab

i  

 

$ source /opt/poky/2.0.2/environment-setup-cortexa5hf-vfp-poky-linux-gn

ueabi  

 

$  
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18.2 Use the C Cross Compilation Toolchain 

Step 1: Use $CC command to compile the C source file. 

Step 2: Use scp command to upload the compiled file to the Matrix-700. 

 

dir: ~ 

$ cat hello.c 

#include <stdio.h> 

 

int main(){ 

printf("Hello World!\n"); 

return 0; 

} 

 

 

dir: ~ 

$ $CC -o hello_c hello.c 

 

dir: ~ 

$ scp hello_c root@192.168.1.70:/home/root 

root@192.168.1.70's password:  

hello_c                                       100% 9800     9.6KB/s   00:00     

 

dir: ~ 

$  

 

 

18.3 Use the C++ Cross Compilation Toolchain 

Step 1: Use $CXX command to compile the C++ source file. 

Step 2: Use scp command to upload the compiled file to the Matrix-700. 

    

dir: ~ 

$ cat hello.cpp 

#include <iostream>  

using namespace std; 

int main() {  

cout << "Hello! World!\n";  

return 0;  

} 

 

dir: ~ 

$ $CXX -o hello_cpp hello.cpp 

 

dir: ~ 

$ scp hello_cpp root@192.168.1.70:/home/root 

root@192.168.1.70's password:  

hello_cpp                                     100%   11KB  10.9KB/s   00:00 

 

dir: ~ 

$  

 

 

 



Matrix-700 User Guide 

 

‧22‧ 

18.4 Use Native C Compilation Toolchain 

User application can also be developed on the Matrix-700 directly.  By default, gcc toolchain is 

pre-installed on the Matirx-700. 

 

Use the gcc command to build a C source file. 

 

[root@Matrix700 ~]#cat hello.c 

#include <stdio.h> 

int main() 

{ 

 printf("Hello World!\n"); 

} 

 

[root@Matrix700 ~]#gcc -o hello hello.c 

 

[root@Matrix700 ~]#./hello 

Hello World! 

 

[root@Matrix700 ~]# 

 

18.5 Install Native C++ Compilation Toolchain 

Users can also install C++ toolchain via apt-get.  Two packages are needed to build a C++ source file, 

the g++ package and the g++-symlinks package. 

 

[root@Matrix700 ~]#apt-get update 

[root@Matrix700 ~]#apt-get install g++-symlinks g++ 

Reading package lists... Done 

Building dependency tree        

Reading state information... Done 

The following NEW packages will be installed: 

  g++ g++-symlinks 

0 upgraded, 2 newly installed, 0 to remove and 63 not upgraded.  

Need to get 222 kB of archives. 

After this operation, 0 B of additional disk space will be used. 

WARNING: The following packages cannot be authenticated! 

  g++ g++-symlinks 

Install these packages without verification? [y/N] y 

Get:1 http://www.artila.com/download/deb/cortexa5hf-vfp/ cortexa5hf-vfp

/main g++ 

 armel 5.2.0-r0 [221 kB] 

Get:2 http://www.artila.com/download/deb/cortexa5hf-vfp/ cortexa5hf-vfp

/main g++ 

-symlinks armel 5.2.0-r0 [780 B] 

Fetched 222 kB in 1s (178 kB/s) 

Selecting previously unselected package g++. 

(Reading database ... 10440 files and directories currently installed.) 

Preparing to unpack .../g++_5.2.0-r0_armel.deb ... 

Unpacking g++ (5.2.0-r0) ... 

Selecting previously unselected package g++-symlinks. 

Preparing to unpack .../g++-symlinks_5.2.0-r0_armel.deb ... 

Unpacking g++-symlinks (5.2.0-r0) ... 

Setting up g++ (5.2.0-r0) ... 

Setting up g++-symlinks (5.2.0-r0) ... 

[root@Matrix700 ~]# 
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18.6 Use Native C++ Compilation Toolchain 

Use g++ command to build a C++ source file. 

 

[root@Matrix700 ~]#cat hello.cpp 

#include <iostream>  

using namespace std; 

int main() {  

cout << "Hello World!\n";  

return 0;  

} 

[root@Matrix700 ~]#g++ -o hello_cpp hello.cpp 

[root@Matrix700 ~]#./hello_cpp 

Hello World! 

[root@Matrix700 ~]# 

 

18.7 Use the Python Interpreter 

The Matrix-700 comes with pre-built Python 2.7 interpreter. 

 

[root@Matrix700 ~]#python 

Python 2.7.9 (default, May 23 2016, 16:12:48)  

[GCC 5.2.0] on linux2 

Type "help", "copyright", "credits" or "license" for more information. 

>>> 

 

 

 

The Matrix-700 also supports pip.  

 

[root@Matrix700 ~]#pip list 

You are using pip version 7.1.0, however version 8.1.2 is available. 

You should consider upgrading via the 'pip install --upgrade pip' comman

d. 

bottle (0.12.9) 

Flask (0.10.1) 

itsdangerous (0.24) 

Jinja2 (2.8) 

MarkupSafe (0.23) 

pip (7.1.0) 

pyserial (3.0.1) 

setuptools (21.0.0) 

uWSGI (2.0.13.1) 

Werkzeug (0.11.10) 

wheel (0.29.0) 
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APPENDIX 

A. How to Configure WiFi USB Dongle 

 
## install driver 

apt-get install kernel-module-rtl8192cu 

 

## modify interface configure (/etc/network/interfaces) 

# Wireless interfaces 

auto wlan0 

iface wlan0 inet dhcp 

    wireless_mode managed 

    wireless_essid Artila 

    #wpa-driver wext 

    wpa-driver nl80211 

    wpa-conf /etc/wpa_supplicant.conf 

     

     

## modify wpa_supplicant.conf (/etc/wpa_supplicant.conf) 

ctrl_interface=/var/run/wpa_supplicant 

ctrl_interface_group=0 

update_config=1 

ap_scan=1 

 

network={ 

  ssid="Artila" 

  key_mgmt=NONE 

  wep_key0=ABCABCABC 

} 

 

## restart networking or reboot 

/etc/init.d/networking restart 

 

 

B. Webmin for Matrix-700 

 

Category Function name Webmin function name 

User Manager User List System/Users and Groups 

System Manager 

Network Interface 
Networking/Network Configuration/Network 

Interfaces 

DNS 
Networking/Network Configuration/Hostname and 

DNS Client 
Login Message NA 
Bootup and Shutdown System/Bootup and Shutdown 
Running Process System/Running Processes 
Disk Manager System/Disk and Network Filesystems 
System Information NA 

 

https://192.168.2.127:10000 

Username: admin 

Password: admin 

https://192.168.2.127:10000/
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 Root (System) 

Path: System 

 

 User Manager 

Path: System/User and Groups  

 

 

 System Manager 

Path: System/Network Configuration 
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 Network Interface 

Path: System/Network Configuration/Network interface 

 

 

 DNS 

Path: System/Network Configuration/Hostname and DNS clients 

 

 

 Bootup & Shutdown Function 

Path: System/Bootup and Shutdown 
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 Running Process 

Path: System/Runing processing 

 

 

 Disk and Network Filesystems 

Path: System/ Disk and Network Filesystems 

 

 

Setup Eclipse IDE 

 Download Eclipse IDE for C/C++ Developers (Luna) from http://www.eclipse.org/downloads. 

 Select "Install New Software" from "Help" menu. 

 Add “Luna - http://download.eclipse.org/releases/luna”. 

 Select the Linux Tools LTTng Tracer Control, Linux Tools LTTng Userspace Analysis, and LTTng 

Kernel Analysis from “Linux Tools”.  If these selections do not appear in the list, that means the 

items are already installed. 

 Expand the box next to "Mobile and Device Development" and select the following boxes. 

 

Again, if any of the following items are not available for selection, that means the items are already 

installed: 

 C/C++ Remote Launch (Requires RSE Remote System Explorer) 

 Remote System Explorer End-user Runtime 

 Remote System Explorer User Actions 
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 Target Management Terminal (Core SDK) 

 TCF Remote System Explorer add-in 

 TCF Target Explorer 

 Expand the box next to "Programming Languages" and select the C/C++ Autotools Support and 

C/C++ Development Tools boxes.  For Luna, these items do not appear on the list as they are 

already installed. 

 Complete the installation and restart the Eclipse IDE 

Install the Eclipse Yocto Plug-in 

 In Eclipse, select "Install New Software" from the "Help" menu. 

 Add URL “http://downloads.yoctoproject.org/releases/eclipse-plugin/2.0/luna” and provide a 

meaningful name. 

 Select Yocto Project ADT Plug-in, Yocto Project Bitbake Commander Plug-in, and Yocto Project 

Documentation plug-in. 

 Complete the installation and restart the Eclipse IDE. 

 

Configuring the Cross-Compiler Options 

 Choose "Preferences" from the "Window" menu to display the Preferences Dialog. 

 Click "Yocto Project ADT" to display the configuration screen. 

 Selecting the Toolchain Type: Standalone pre-built toolchain. 

 Point to the Toolchain: /opt/poky/2.0.2. 

 Specify the Sysroot Location: /opt/poky/2.0.2/sysroots. 

 Select the Target Architecture: cortexa5hf-vfp-poky-linux-gnueabi. 

 

Example: Creating a Hello World Project 

 Select "Project" from the "File -> New" menu. 

 Double click C/C++. 

 Double click C Project to create the project. 

 Expand Yocto Project ADT Autotools Project. 

 Select Hello World ANSI C Autotools Project.  This is an Autotools-based project based on a 

Yocto template. 

 Put a name in the Project name: field.  Do not use hyphens as part of the name. 

 Click "Next". 

 Add information in the Author and Copyright notice fields. 

 Click "Finish". 

 Right-click in the navigation pane and select "Reconfigure Project" from the pop-up menu.  This 

selection reconfigures the project by running autogen.sh in the workspace for your project. 

 To build the project select "Build Project" from the "Project" menu. 

C. Restore to Default 

1. Create a bootable SD 

Please prepare a micro SD card (8GB capacity is recommend) and a SD card adapter. 
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1.1 For Windows 

1.1.1. Download ‘win32diskimager’ from https://sourceforge.net/projects/win32diskimager/ 

 

1.1.2. Image and Document are downloaded from 

http://www.artila.com/download/A5D35/Linux/image/restore_700 

 

1.1.3. Load ‘win32diskimager’ and browse for the image file,’restoreSD.img’, selecting it. 

 

 

1.1.4. Next, set the drive letter for the Device and click Write to begin reimaging. 

 

 

1.2 For Linux 

Using ‘dd’ command , for example, 

sudo dd bs=1m if=<image file>.img of=/dev/<disk#> 

sudo dd bs=1m if=restoreSD.img of=/dev/sdc 

 

2. Insert bootable SD to Matrix-700 and power-up it, then entrance the root directory. (User: root / 

Password: root) 

 

3. Execute ‘restore’ command.  If the command can’t be found, just install it from our repository. 

 

For example: 

apt-get update 

 

[root@Matrix700 ~]#apt-get update 

Ign http://www.artila.com Matrix700 InRelease 

Ign http://www.artila.com cortexa5hf-vfp InRelease 

Ign http://www.artila.com all InRelease 

Ign http://www.artila.com Matrix700 Release.gpg 

Ign http://www.artila.com cortexa5hf-vfp Release.gpg 

Ign http://www.artila.com all Release.gpg 

Ign http://www.artila.com Matrix700 Release 

https://sourceforge.net/projects/win32diskimager/
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Ign http://www.artila.com cortexa5hf-vfp Release 

Ign http://www.artila.com all Release 

Get:1 http://www.artila.com Matrix700/main armel Packages [441 kB] 

Get:2 http://www.artila.com cortexa5hf-vfp/main armel Packages [2200 kB] 

Get:3 http://www.artila.com all/main armel Packages [38.1 kB] 

Ign http://www.artila.com Matrix700/main Translation-en 

Ign http://www.artila.com cortexa5hf-vfp/main Translation-en 

Ign http://www.artila.com all/main Translation-en 

Fetched 2679 kB in 16s (167 kB/s) 

Reading package lists... Done 

 

apt-get install restore 

[root@Matrix700 ~]#apt-get install restore 

Reading package lists... Done 

Building dependency tree... Done 

restore is already the newest version. 

0 upgraded, 0 newly installed, 0 to remove and 0 not upgraded. 

 

4. The process of restore won’t be finished until the ready LED is always ON.  The estimated time 

for restore progress that take around 10 minutes. 

 

 

 


